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Regression

Regression

Y-Block| <Gt———— X-Block

Model

What’s desired What’s measured

Regression analysis identifies the dependency
between two blocks of data.

Regression models are often used to obtain estimates
(or predictions) for one block of data from the other.
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Outline
* Nomenclature and conventions
* C(lassical Least Squares (CLS)
* Inverse Least Squares (ILS) Models
* Multiple Linear Regression (MLR)
* Ridge Regression (RR)
* Principal Components Regression (PCR)
* Partial Least Squares Regression (PLS)
* Determining of the Number of Factors
¢ Qutlier Detection and Model Diagnostics
* A Unitying Theme: Continuum Regression (CR)
e Summary
e Examples
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Conventions & Notation

* Rows correspond to samples, columns correspond to variables
* Notation:

¢ X = matrix of predictor variables

¢ Y = matrix (or vector y) of predicted variables

¢ m = number of samples (observations)

* nx = number of X variables, ny = number of Y variables

¢ T =X-block scores matrix, t,, t,, ... t, score vectors

* U =Y-block scores matrix, u,, u,, ... ,_score vectors

¢ P =X-block loads matrix, p,, p,, --- P, loadings vectors

¢ Q =Y-block loads matrix, q,, q,, ... q, loadings vectors

* W =X-block weights matrix, w,, w,, ... w, loadings vectors

¢ O =ridge parameter




Data Preprocessing

Everything that was said about preprocessing for
PCA goes double for regression

Data should be linearized, if possible
Data is almost always mean centered

Variance scaling used when variables are in
different units or greatly different magnitudes

Outlier elimination is critical to regression models
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Classical Least Squares

CLS can be used to develop calibration models

* most often used in spectroscopy
The CLS model assumes the data follows:
X=CST+E

where X (mxnx) is the measured response, S (nxxk)
is a matrix of pure component responses, C (mxk) is
a matrix of weights (i.e. concentrations), and E
(mXnx) 1S noise or an error matrix
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Absorbance

The CLS Model

e Given known pure component spectra, how much
of each does it take to make up the observed
spectrum?
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The CLS Model

e Given known pure component spectra, how much
of each does it take to make up the observed
spectrum?

. . . . . . .
800 900 1000 1100 1200 1300 1400 1500 1600
Wavelength (nm)

@ EIGENVECTOR

E-fa RESEARCH INCORPORATED



10

CLS (cont.)

* Once S (the spectral “basis™) is known, ¢, the
degree to which each component contributes to a
new sample x, can be determined from
¢ =x5"
where S*is the pseudo-inverse of S, defined in
CLS as S+ =S(STS)!

* Problem: How to get S?
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Classical Least Squares

X=CST+E
X =CST

XS =CSTS
XS(STS)1=C
S+ = S(STS)"!

* Note that STS is kxk (analytes by analytes)
and square
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Estimating S

e Sometimes, S can be compiled a priori, e.g. from
a data base/spectral library, or from direct
measurements of pure components

* Problem: must account for all components that can

contribute to X!

* S can also be estimated from mixtures, provided
all C are known and enough samples are

available:

ST = (CTC)'IC™X
e Problem: The concentration of every analyte that
contributes to X must be known!
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CLS Example

* NIR data of pseudo-gasoline samples

¢ absorbance at 401 channels

e 30 samples
e 5 analytes

(in analysisGUI..)

File/Load Data/Xblock:
nir_data, “specl” array

Edit/Plot X-block (Data)
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Set up Calibration and
Validation Sets

>> load nir_data

>> conc_cal = conc(1l:24,:);
>> conc_val = conc(25:30,:);
>> spec_cal = specl(1:24,:);
>> spec_val = specl(25:30,:);
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Load into Analysis Interface

800 Analysis - CLS (No Model) [sXeXe) Analysis - CLS (No Model) -
Tools Help FigBrowser [l Edit Preprocess Analysis Tools Help FigBrowser

Load Data il Calibration »
— Import Data  »

il X-Block

Import Data » ion »  Y-Block

X-Block

New Data New Data
Load Model Load Model
Import Model Import Model

Load Prediction Load Prediction b idati
e e —
ave Data »

Sl [Variance c. c del

‘Analysis Help tanor ' other options (irom e
imported andior a model can be loaded using the File menu. librate a model The dala can be
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Set Preprocessing, Calculate
Model

00 Analysis - CLS 5 comp - specl, conc
File Edit Preprocess Analysis Tools Help FigBrowser
~ (X Wi

Y-block * | Mean Center

X i J—— X Y Autoscale X P i X
0ad Preprocessing Model Prediction
Y Save Preprocessing  * ‘ Custom... Y P Y
Plot Preprocessed Data » | Set Current As Default oo It _|—___ x|

Number of Components: [Number of Components: | 5

Data has been Setthe and The and applied
d librate a model (C: data. Review the prediction results using the Toolbars butions. The number of components.
The dala

d
viewed and ediled with the Edit menu. . and other seltings
can be viewed and edited from the Edit menu.

Set preprocessing to “none” in both X and Y
Click “Model” to calculate 5% EIGENVECTOR
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Pure Component Spectra

® OO  Figure 1: Variable ngs - CLS 5 comp - s|

File Edit View Insert Tools Desktop Window Help
» DEES b RANE® ¥ 0B 0O

Plot Controls

| File Edit View Plot FigBrowser - Variables!Loadings Plot for spec 1

PlotGUI

| Fig 1: variables/Loadings - CLS 5 comp... & |

x:| Variable )

Y
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2| none :
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Estimate for Unused (Test)
Samples

000 Figure 1: Samples/Scores - CLS 5 comp - specl, conc

File Edit View Insert Tools Desktop Window Help FigBrowser PlotGUI
» DBES h RANS ¢ 0B 5O
SWafScovesPIntnlspec!,c&snecL wsamp!ee«'swvesPIntnlspec!,c&specL
3 5
32 v
3 rw Ea
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gp SSmPlesISeores Plotofspec o spect, g SmolesiScares Plotof specto&apect,
3 = o
§ ! }./‘/'." % “ =t
> ol > =27
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YMeasured 4 ¥ Measured 5
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CLS Problem
* What if the concentration of 1 analyte was
unknown?
* Repeat the CLS procedure using only the first
4 (of 5) analytes
e Attempt to predict concentrations of unused
(test) samples
« w8 EIGENVECTOR
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Remove 5th Analyte

(OO 7 selectY-Columns

Preprocess Analysi Tools Help FigBrowser

Select Y-Columns to use
Lo X-block Data !
Validation » | Plot X-block ggimé
olimn
Options Y-block Data TRt jconmng

Plot Y-block
olumns Validation

Percent Variance Captured by Model
Component  Fit Fit mulative
Number (3Model) it (3%)

1 9

2 3.2

3 3

The model had been calibrated from the calibration data and applied to the test (validation)
data. Review the prediction resuls using the Toolbars buttons. The number of components, —
preprocessing options, and other setlings can also be modified to adjust the model. The data

can be viewed and edited from the Edit menu.
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CLS Solution-Missing Analyte

@) o
File Edit View Insert Tools Desktop
» DEES k RAN ¥ 08 =

igBrowser  PlotGUI

 xSblsiSiores ot of spec oo |, 5o  SSesIScure P ofspec s dspeet,
.
32 ;
R £
>
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Inverse Least Squares
* Inverse least squares (ILS) models assume that the
model is of the form:
Xb=y+e
where y (mx1) is a property to be predicted, X
(mXnx) is the measured response, e (mx/) is an

error vector, and b (nxX/) is a vector of
coefficients

e Unlike CLS, ILS methods associate the noise with
the predicted property, not the measured response
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Estimation of b: MLR

[t is possible to estimate b from
b=X"y
whereX " is the pseudo-inverse of X

e There are many ways to obtain a pseudo-inverse
most obvious is multiple linear regression (MLR),
a.k.a. Ordinary Least Squares (OLS)

e In this case X" is estimated from
-1
X' = (XTX) X’
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Multiple Linear Regression

Xb=y+e
Xb=y

X'Xb = X"y
b=(X"X) X'y

X' = (XTX)_1 X’

* Note that X'X is nxXnx and square

P EIGENVECTOR
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Advantage of ILS Methods

e ILS methods (including MLR, PCR, PLS, CR)
don’t require the concentration of all analytes,
including interferents, be known ...

e ...however, interferents must vary in the
calibration data set for the the ILS regression
model to be robust against them

P EIGENVECTOR
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Problem with MLR

e Inverse of X'X only exists if
¢ Rank(X) = nx, but rank(X) < min (m,nx)
* X has more samples than variables i.e. if m=nx
e problem with spectra

¢ Columns of X are not co-linear

* Inverse may exist but be highly unstable is X is
nearly rank deficient

 In these cases, small perturbations in the data
(possibly due to noise) can produce very different
results

P EIGENVECTOR

25 @\ RESEARCH INCORPORATED

MLR Example

e Use MLR to obtain a relationship between
temperature and level in a SFCM
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Load and Edit Data

Class

dataset
dataset
dataset
dataset

>> clear
>> load plsdata
>> whos
Name Size Bytes
xbTockl 300x20 55240
xblock2 200x20 38440
yblockl 300x1 9008
ybTlock2 200x1 7408
>> X = xblockl.data(delsamps([1:300]"',[73 167
>> y = yblockl.data(delsamps([1:300]"',[73 167
>> [mx,mnx] = mncn(x); %center the data
>> [my,mny] = mncn(y);

object
object
object

object

278 2791),:);
278 2791),:);
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...or via the Analysis GUI

I-Load x and y for both
calibration and validation

2-Select Edit/Calibration/X-block  &he

Data

000 Analysis - MLR (No Model) - xblockl, yblockl

| File )0 Preprocess Analysis Tools Help FigBrowser
Elll”. Calibration » ~ X_block Data
= Plot X-block

Validation »
& Options >

Y-block Data
Plot Y-block
lect Y-Columns

3-Select Row Labels tab

000

xblock1 - DataSet Editor

i

3
H

File Edit ViewAigBrowser
Row Labeis | Column Labels |

6! Sampis (urme)

Label

[ s scae Class

[ set1 omety)

][ setv i Fo[ settmoy [

‘Samplo Number

P
H

T

RRRAARARRRRCAR

Data has been lo:
Preprocess and Tor
and edited with th

aded
ol
e Edit me

but Setthe and other options (
is menus) and calibrale a model (Calibrate button). The data can be viewed
nu.

4-Deselect samples 73, 167,
278 & 279, then close
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MLR Regression and Results

>> bmlr = mx\my; 2
>> sx = scale(xblock2.data,mnx);
>> ymlr = rescale(sx*bmlr,mny); s

[N]
o
o

Known and Estimated Level
S
o
-

20

198 L L L L L L L L L
1) 20 40 60 80 100 120 140 160 180 200

Sample Number (time)
>> plot(1:200,yblock2.data,'o-b',1:200,ymlr,"'-r+')
>> x1abel('sample Number (time)')
>> ylabel('Known and Estimated Level')
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MLR Results

1-Set X-block preprocessing
to Mean Center
2-Click Model

000 Figure 1: Samples/Scores - MLR - xblock1, yblock1
© O O plot Control File Edit View Insert Tools Desktop Window Help FigBrowser PlotGUI
ot Controls =
il Edi v Plo Fghron - DSES & QaHD & 0@ 50

| Fig 1: Samples/Scores - M... 3 | Samples!Scores Plot of xblock2
{ J T T T

21 T T

x:| Sample 44

Y Resdual 1 Level 208

= 206 1
2
£
3
2 none ry £
: : > 204 r
i
g
V! auto-update =
£ 202
I Selact || oot 3
8
= I
[ Qeon ” Teon > !
20 ——— YMeasured 1 Level
‘ data | [ info ¥ Predicted 1 Level

] Show Cal Data with Test

) e 19.8
L] Conf. Limks: 3 3 20 40 60 80 100 120 140 160 180 200

3-Select Scores
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Ridge Regression

* Ridge Regression (RR) is one way to deal with ill-
conditioned problems

* RR gets its name because a constant is added to
the “ridge” of the covariance matrix in the
formation of the pseudo-inverse:

X" =(X'X+ I@)_l X’
¢ The addition of O stabilizes the inverse and
shrinks the values of the coefficients

\
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RR Shrinkage

[brr,theta] = ridge(mx,my,0.015,31);

0.015

Vertical line shows
best guess for theta
theta = 0.00715026

0.01

0.005

0

-0.005 5

-0.01
0

P.adll
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RR and MLR Regression
Vectors

>> plot([bmlr,brr],'o-","'linewidth',2)
>> legend('MLR','RR")
>> hline
0.015 T T T T T T T T T

-~ MLR
-~ RR

001}

0.005
e

-0.005

-0.01
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P.adll

Problem with MLR and RR

* RR helps stabilize the inverse but still has
problems with strong co-linearity

e Neither MLR nor RR work when m<nx
* Possible solution: eliminate variables, e.g.
stepwise regression or other variable selection
* how to choose which variables to keep?
* lose multivariate advantage - signal averaging
e Another solution: use PCA to reduce original
variables to some smaller number of factors
* retains multivariate advantage
* noise reduction aspects of PCA

i EEEEEIGENVECTOR
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Principal Components
Regression

 Principal Components Regression (PCR) is one
way to deal with ill-conditioned problems

* Property of interest y is regressed on PCA scores:

k

X =P,(T/T,) T

¢ Problem is to determine k the number of factors to
retain in the formation of the model

P EIGENVECTOR
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Principal Components
Regression

kapc =y+e= XPkbpcﬁ b= Pkbpc
Tb =y

k™ pc

-1
T T b=P (T/T) Ty
T, kapc =Ty

X' =P (T7T,) T7

k

b, =(T'T,) 17

* Note that T/T, is kxk and square
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Cross-Validation

* Divide data set into j sample subsets
e For each subset (j times):

* Build PCA model using all samples in the remaining
subsets

* Apply the model to the subset samples

¢ Calculate PRESS (Predictive Residual Sum of
Squares) for the subset samples:

e’ = (y - Xb)2

e Look for minimum or “knee” in PRESS curve
w3 EIGENVECTOR
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Cross-validation Graphically

form model with then

I

to
use predict

i

break data
into subsets

round 1

N\

round 2
2

NN

calculate
prediction error
for each subset
as a function of
number of PCs

i
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Formation of Test Sets

1

“Venetian contiguous random leave-one-
blinds” - OK  blocks-best selection- out, used
when data for time usually when not
already in series repeated much data
random several times available
order

Custom selection, based on
prior knowledge!

5 @8EIGENVECTOR
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What else?

Cross-validation Considerations

e Cross Validation method selection criteria
* Number of objects in dataset
* Order of objects in dataset
* Objective of cross-validation (specific type of error?)
¢ Presence/absence of replicates
e “Traps” to avoid
* “Replicate sample trap”
* Different replicates in both model and test set
» “External subset selection trap”
* Test set “space” outside of model set “space”

40 EEEEEIGENVECTOR
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Cross-validation Usage Matrix-I

General Properties

Venetian Blinds Contiguous Blocks Random Subsets |Leave-One Out |Custom
e Easiest! (Only
o Easy o Easy o Easy one parameter) e Flexible

o Relatively quick

o Relatively quick

m or number of
iterations large
e Selection of

e Can be slow, if

subsets unknown

o Avoid using if
m>20

o Requires time
to determine/
construct cross
validation array

Small data sets (<~20
objects)

o OK, if many
iterations done

¢ Good choice....
e ...unless
designed/DOE
data

o often needed to
avoid the external
subset selection
trap

randomly-distributed
objects

e Good choice

e Good choice

« Good choice

iterations

¢ Can take a while
with large m, man

e OK, but....

¢ Can take a while
with large m

41
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Cross-validation Usage Matrix-Il

Venetian Blinds Contiguous Blocks Random Subsets [Leave-One Out JCustom
e Useful for assessing
NON-temporal model
errors
* Can be optimistic « Useful for assessing
with low number of data | temporal stability of
time-series data splits model . o 0

Batch data

e Useful for assessing
predictability within
batches/parts of
batches

e Useful for assessing
predictability between
batches/parts of batches

e Can manually
select “batch-wise”
. test sets

Blocked data

e Beware the
replicate sample trap

e Good way to avoid
replicate sample trap
* Beware the external

e Canuseto
avoid replicate
sample trap (high

e overly optimistic
results, due to
replicate sample

Designed Experiment
(DOE) data

object order is
randomized

object order is
randomized

(replicates) (optimistic results)! subset selection trap!  |number of splits, traﬁ o
o Not e often needed to
e Dangerous, unless |e Dangerous, unless recommended avoid the external

(external subset

selection trap)

subset selection
trap

42
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>>
>>
>>
>>
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PCR Cross-Validation Example

e block CV since data is time series

* mean centered, 20 PCs, split 10 times

s = preprocess('meancenter');
opts = crossval('options');
opts.preprocessing = {s s};

[press,cumpress, rmsecv, rmsec] =

0.118

0.117

0.116

0.115

E
{

.
¢ irrelevant PCs

choice for k

crossval(x,y, 'pcr',{'con',10},20,0pts);

0.114
0.113
0.112 '

0.111 . ¢

0.11
0

...or via the GUI

1-Reset Analysis to “PCR”

000 Analysis - MLR - xblock1, yblockl

File Edit Preprocess WP Tools Help FigBrowser
~ (K] 85 MM A pcA

Purity i

MCR X

PARAFAC Prediction

Ci Validation
L—— Custer —]———————|
View: | Funcuon sott opuiso Varable Solecion |
The model fr and applied to the data.
Review Tesulis using the Toolbars butions, The. X
an also be modified to The data can

B viewed and edited from the Edit ment

2-Select Tools/Crossvalidation
3-Set to “Contiguous Block”

Cross-Validation

1 cacal |

EEIGENVECTOR
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PCR Variance Captured

>> options = pcr('options');
>> options.preprocessing = {s s}; % s is mean centering
>> modelpcr = pcr(x,y,6,options);

Percent Variance Captured by PCR Model

————— X-Block----- -----Y-Block-----

PC # This PC Total This PC Total
1 81l.61 81l.61 85.23 85.23
2 6.16 87.717 0.19 85.41
3 5.22 92.98 0.30 85.71
4 2.54 95.53 0.02 85.74
5 1.37 96.90 0.17 85.91
6 1.01 97.91 1.09 86.99
7 0.46 98.37 0.05 87.04
8 0.39 98.76 0.27 87.31
9 0.36 99.12 0.30 87.61
10 0.24 99.37 0.02 87.63

45
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Problems with PCR

e Some PCs not relevant for prediction, but are only
relevant for describing variance in X
* leads to local minima and increase in PRESS
 This is a result of PCs determined without using
information about property to be predicted y

e A solution is to find factors using information
from y and X

P EIGENVECTOR
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Partial Least Squares

e PLS is related to PCR and MLR

e PCR captures maximum variance in X
¢ MLR achieves maximum correlation between X and Y

* PLS tries to do both by maximizing covariance between
Xand Y

* Requires addition of weights W to maintain
orthogonal scores

» Factors calculated sequentially by projecting Y
through X

X" = W, (PkTWk )1 @JTk )lTkT

\

@\ RESEARCH INCORPORATED

EEEEEIGENVECTOR

PLS Cross-Validation Example
e use block CV since data is time series
* mean centered, 20 PCs, split 10 times

>>[press,cumpress, rmsecv,rmsec] = crossval(x,y,'sim',{'con',10},20,0pts);

48

0.118
0.117
no irrelevant factors

0.116; ®
0.115 ® 4
0114 choice for k |

9o o4

A L]
0.113 P ° --.,,,0 ® ]
.
0.112 ]
.
0.111 o . ° ]
0.1 o? (A T]
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...or the easy way

Analysis - PLS 3 LVs - xblock1, yblock1
File Edit Preprocess Analysis Tools Help FigBrowser
» [0 88 Wvase

Figure 1: Model Statistics - PLS 3 LVs - xblockl, yblock1
= File Edit View Insert Tools Desktop Window Help FigBrowser PlotGUI

| = =
m X » DEESE k QQN® & 08 60
m — = ROl . SMPLS Yernce Caturedand Saistis ook
Calibration Validation
I 1 ==
ey SSQ Tat 01167
ok
Tom
B
§
g
3
4 3 0108
; ads ) §
®O0O0 PotControls ..., 3 0108
: File Edit View Plot FigBrowsei
o0
L 3 -
1 || P 1: Model Statstis -PLS 1 LVs— | 44] 4\
B a ) 0.102 4\0\.\_’_
The mogeineo: el "
eviow the precicton resuls hanis !
preprocessing oplons. and o Tiode! The data ¢ 2 T I R R R

be viewed and edited from the| Lelent Varible Number

r_‘- .

2| none =]
[ Pot_| & autoupdats
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PLS Variance Captured

>> options = pls('options');
>> options.preprocessing = {s s}; % s is mean centering
>> modelpls = pls(x,y,3,options);

Percent Variance Captured by PLS Model

————— X-Block----- -----Y-Block-----

LV # This LV Total This LV Total
1 81.61 81l.61 85.33 85.33
2 5.15 86.76 1.12 86.45
3 2.01 88.77 1.14 87.59
4 4.91 93.68 0.18 87.77
5 1.55 95.23 0.30 88.07
6 1.66 96.89 0.15 88.22
7 1.21 98.10 0.05 88.27
8 0.37 98.47 0.07 88.34
9 0.21 98.68 0.08 88.42
10 0.31 99.00 0.05 88.48
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Regression Vectors

>> plot([bmlr modelpcr.reg modelpls.reg],'+-", 'lTinewidth',2)
>> legend('MLR','PCR','PLS'), hline

0.015 T T T T

0.01

0.005

-0.005

-0.01

—+ MLR
—+ PCR
—— PLS

EEIGENVECTOR
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PLS NIPALS Algorithm

51
Choose u; =y or one column of Y
XTuI
wl = T
HX “I‘ )
t, = Xw, o)
T
u t
" Tl
u t, 3)
ul = qu (4)
Check for convergence by comparing t] to
previous t. If Y =y skip (3) and (4) and continue
X't
P, = 77
el ] )
p — plold
Inew leom (6)
52

Einew = o] P o (7)
Winew = Wio | Prow (8)
Find the regression coefficient for the inner

relation:

T
u t
b = 1
ot

(&)

After calculating scores and loadings for first
Latent Variable, the X and Y-block residuals are
calculated:

_ _ T
E =X -tp, (10)

_ _ T
Fl =Y u,q, (11)

Repeat entire procedure replacing X and Y with

their residuals

EEIGENVECTOR
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Other PLS Algorithms

It can be shown that w, is given by
XYY Xw, = 2w,
e The SIMPLS algorithm uses an orthogonalization
of a Krylof sequence (faster than NIPLS algorithm)
e The important thing to remember is:

PLS finds factors in X which are correlated with Y
while describing large amounts of variance in X

P EIGENVECTOR
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Y Projected onto X Plane

X-block Variables

2
15 1
*®
°
1 o® ® . o
¢ ® j
05 * ..
° °
R0 ° ®
° °®
05 o,
-1 L )
-1.5
2 s s
-2 1 u] 1 2
1
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PCA of X-Block

X-block Variables

18 /’#F; ™.

A

P EIGENVECTOR
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MLR Regression Vector and
Surface

15 T
S .U
-1
2 s
“ ws= EIGENVECTOR
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PCR Regression Vector and
Surface

X-block Variables
, ock Variable MLR

1. -
) e TNPCR
! s ¢ - j'

»
05 /o ’: i
/ et o
R0t e e 71
asp b ¢ ot ]
1 e

15

2% 1 1 2
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PLS Regression Vector and
Surface
X-block Variables
M MLR prg
" " e¢ T PCR
1 / o'.._..%:'s ]-

05 /o ’: i
oo o, oY
05 \ ® 6,’ 7
1 e g
15
2% 1 0 1 2
. @ EIGENVECTOR
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Geometric Relationship of
MLR, PCR, and PLS

MLR
. PLS
PLS is the vector ¥-block Variables / A
on the PCR ellipse 2 PCR
upon which MLR ¢ 5 _
has the longest 1 P / .
projection s
05 /o 0 ’ Line perpindicular
g of | ¢ Do a to the MLR
e : e regression vector
05t ' AP
-1 e R -
-1.5
2 .
-2 -1 1 2
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PLS for Multivariate Y

* PLS can be used to relate multivariate X to
multivariate Y (a.k.a. PLS2)

e outer relationships
X=T,P' +E
Y=UQ, +F

e inner relationship
U, =T.B,

* j.e.the scores in Y are linear combinations of the

scores in X

EEFEEIGENVECTOR
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PLS2

X-Block Outer Model Y-Block Outer Model
1st PC 1st PC

q1
X2

I Slope=b
uj
w, and q, are similar to PCs in X
and Y but they are rotated so that
there is better correlation between

9]

4 (=Xw)) and u, (=Yq,) Eiﬁi EIGENVECTOR
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Model Quality Measures

* Root Mean Square Error
(RMSE) Metrics

e RMSEC Z(Yl _JA’Z')Z
« RMSECV =
e RMSEP

* In units of the Y variable!

m

» Correlation Coefficient (r) 3650, -7)
\/[2 65750

e Unit-less
e Considers the range of Y

\
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Root Mean Square Error (RMSE)
Metrics

* These are used to assess a model’s fit to the data
and predictive ability on new data

* Measures “average” deviation of model estimates
from the measured data

* Measure of fir - root mean squared error of
calibration (RMSEC)

2 .
i(y A ) i’s refer to all
i " Y samples used to

= build the model

RMSEC =
m

EEEIGENVECTOR
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Cross-Validation Error

* RMSEC measures fit to the model data. RMSECV (root
mean squared error of cross-validation) is an estimate of
predictive power on new data.

e RMSECY is a function of the number of factors k and
how the test sets were selected

j’s refer to different

ii(y _J,})z CV subsets

ra PRESS
RMSECV =12 =,/ : i’s refer to CV subset
mj mj

samples- not used to
build CV models

P EIGENVECTOR
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Prediction Error

¢ Prediction error is often used to validate a model
and is a true measure of the predictive power on
new data

* Measure of prediction error - root mean squared
error prediction (RMSEP)

i’s refer to
samples NOT

used to build the
model

RMSEP =

\
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EEEEEIGENVECTOR

RMSE metrics, as a function of
factor (PC, LV)

0.125
- ot ¥,/*"'+ +
012 rs | RMSEC and
S, RMSECV can
—
0.115] also be used to
—— RMSECV Level .
\ determine the
011} | optimal number
Tk of factors (LVs,
T, N PCs) to be used
0.105 et . del
plsdata, X = xblockl, Y = Yblockl, 1n a mode
PLS, CV = 10 contiguous blocks
0.1

2 4 6 8 10 12 14 16 18 20
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Comparison of Models

e MLR, PCR, and PLS models were constructed
using SFCM data: Calibration used (xblock1) and

test used (xblock?2).

MLR PCR PLS
RMSEC 0.0991 0.1059 0.1034
RMSECV 0.1122 0.1108 0.1098
RMSEP 0.1496 0.1366 0.1396

 Fit and prediction are two entirely different
aspects of a model’s performance

P EIGENVECTOR
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Number of PCs or LVs

* Choice is not always simple

* A few rules of thumb
* sqrt(m) a good choice for number of splits
¢ useful to do repeated CVs with different data ordering
* if data is time series use block CV due to correlated noise
¢ be conservative, models are more often overfit than underfit
* best choice is often not the global minimum PRESS

¢ look for minimum of PRESS and work backwards if improvement
is not at least 2%

¢ RMSEC<RMSECYV by more than ~20% indicates overfit

* look at variance captured in X and Y. Is it significant with respect
to what you know about the data?




